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1.0 INTRODUCTION
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and organizatior ¢
These tools can enable an individual to work efficiently in an organization. The essentials of Microgsof Offics
are critical for the employees' professional growth as well as for the company's advancement 1t i« eetiras /
that at least 1.2 billion people across the globe use Microsoft Office, making it very popular rs‘ ‘c N
may not be the latest tools, but the features are so widespread that no application or competition i 1.
business can replace these tools. These tools are so flexible and beneficial that whether it is a small-sczle o
a large-scale industry, these tools are needed, and their features are incomparable. Any professional f«
for tools that diminish the time and repetition of repetitive work, or they look for a solution that could
simplify their tasks, and they demand services that can make their work easy so that they can focus more
on the completion of their project. This report discusses the extensive usage of Microsoft Office tools where
at least one of the tools will be needed by everyone or every organization. The usage of these tools makes

the task easier, solving real-life problems and reducing time and effort.

1.1 BACKGROUND

Many organizations now recognize that they must use Microsoft Tools to remain competitive in today's

knowledge-based global economy, so they invest heavily in gaining effective benefits as they implement

the new technology. Microsoft Tools has advanced into functional literacy, which is nearly equivalent to
that of reading, writing, and arithmetic as a basic skill for modern office work. The skills often referred to as
functional skills are the direct application of reading, writing, and arithmetic knowledge and include
listening, speaking, numeracy, and computer literacy. Microsoft is widely recognized as essential in 215t
century learning, and many people tend to think about the technological tools that one could use, such as
computers. However, productive Microsoft Office Tools usage is a matter not just of basic facility and
functionality, but also of knowing how to use powerful workplace tools and to use them well and wisely A
person with Microsoft Tools Skills should be able to perform basic computer desktop operations, configure
hardware, and use basic productivity tools such as word processors, spreadsheet tools, database tools, and

presentation graphicsinaway that illustrates their understanding of the tools and their ability to participate

in the kind of activities that have become expected in the basic workplace. The use of Microsott Office tools
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1.2 Brief Remarks by the Municipal Chief Executive (MCE)

on. Municipal Chief Executive welcomed all the participants present and urged the
advantage of this important initiative. According to him, one of the mandate of (‘V(‘ly)l;ry “‘ ” e
ensure the development of its human resource (staff). He said, the Human Res(,ur(r.(,/d::q:;w
important wgunres (Assets) of every business organization have and the performance of the va : ”‘w
is determine by the effectiveness and efficiency of the capability of these persons. Rt

 te
»

He concluded by thanking all participants for making time to attend the training.

1.3 Workshop Objective/Purpose

1.3.1 Workshop Objective (General Objective)

The purpose of this training is to equipped frontline staff (Senior Executive Officers, Stenographer
Secretaries, Typists, Client Service Officers and some core staff of the Krachi West Municipal Assembly with
the basic knowledge and skills in using Microsoft Office-based communication tools on enhancing and

improving the job performance of professionals in the Local Government Service.

1.3.2 Contents/Specific Objectives of the Training Workshop
The training course was designed to enable participants to:

e Define the concept Microsoft Tools

e Brief History of Microsoft Office-Based Communication Tools

o Brief describe some examples of Microsoft Office Tools

e Importance of using Microsoft Office-Based Communication Tools

e Application of Microsoft Office Tools that are regularly use in public and private offices

1.4 Approach and Methodology

The Facilitators adopted participatory approach to all activities during the training workshop. To
ensure quick and more lasting results, participants were actively involved in the training activities

from the beginning to the end.
powerPoint presentation, questions and answers, brainstorming, plenary discussions, and experience

sharing were the methods employed during the training.

1.5 Workshop Participants, Venue and Date
Fourteen (14) persons attended the training. Seven (7) females and Seven (7) males. The list '

participants can be found in appendix one (1) of this report.
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1.8.2 The Concept of Microsoft Based Office Communication Tools

§ NUCTOosOot Otfice T Ol {productivity tools) in the V\J..,\u“““ e has been around f.
I Quite « ’
e made it possible for professionals to manage projects effic iently and ek
12 Ooes ;"‘1«
very important to know spe !fl(‘ln'y how the use of these tools can 155151

fore

WOUR

tivity in the workplace. These tools are a good form of technology that save time Biriss :

EY,and rme
terms Of spreading and sharing information and facilitating effective group collaboratione . .
tools are complex types of software that develop a user's ability to complete tasks effectiyel J and ofs,
Good examples of productivity tools are Microsoft Office tools. There are quite a number

4
,and it

to use the right one for the task at hand. The various Microsoft Office tools assist ir being

& Proguctive

throughout the day. No matter what level of skills a person has, it can function, perform

ana see
o9l assist

increasing productivity. Microsoft Office tools include the following: Outlook, Word, Excel, Powerpeins

Access, OneNote, Lync, SharePoint, Publisher, and InfoPath. Each of these is used for specific t3

(3SKS whirs

l

e

include the dissemination of information, data sharing, meeting up for work group projects, communicas
with colleagues, and keeping up with appointments and conferences.

Everyone working as a professional within the corporate world needs to know how these tools can be

—2T0

to help their business become more productive. Business capability can increase with the use of these too

They have the ability to create professional-looking documents, financial statements, projects, and br et -
presentations.

1.8.3 Brief History of Microsoft Office-Based Communication Tools

Microsoft is a multinational computer technology corporation. Microsoft was founded on April 4
1975, by Bill Gates and Paul Allen in Albuguerque, New Mexico. Its current best-selling products ar

=

the Microsoft Windows operating system; Microsoft Office, a suite of productivity software; Xbox

w

line of entertainment of games, music, and video; Bing, a line of search engines; and Microsoft Azure
a cloud services platform.

In 1980, Microsoft formed a partnership with IBM to bundle Microsoft's operating system with 18\
computers; with that deal, IBM paid Microsoft a royalty for every sale. In 1985, IBM requested
Microsoft to develop a new operating system for their computers called 0S/2. Microsoft produced

that operating system, but also continued to sell their own alternative, which proved to be in direct

VY

competition with 0S/2. Microsoft Windows eventually overshadowed 0S/2 in terms of sales. \

Microsoft launched several versions of Microsoft Windows in the 1990s, they had captured over 307

market share of the world's personal computers.
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for Microsoft Teams calls in order to secure business communication while usi p ~on G
ile using video conferencing
software. Users can ensure that their calls are encrypted and can utilize a security code that b
at both
parties on a call must verify on their respective ends. On October 7, Microsoft acquired All
! y.io, a
software service that measures companies' progress against OKRs. Microsoft plans to incorporat
e

Ally.io into its Viva family of employee experience products.

On January 18, 2022, Microsoft announced the acquisition of American video game developer
and holding company Activision Blizzard in an all-cash deal worth $68.7 billion. Activision Blizzard is
pest known for producing franchises, including but not limited to Warcraft, Diablo, Call of
puty, StarCraft, Candy Crush Saga, Crash Bandicoot, Spyro the Dragon, Skylanders
and Overwatch. Activision and Microsoft each released statements saying the acquisition was 10
benefit their businesses in the metaverse, many saw Microsoft's acquisition of video game studios as
an attempt to compete against Meta platforms, with TheStreet referring to Microsoft wanting t¢
become "the Disney of the metaverse". Microsoft has not released statements regarding Activision
recent legal controversies regarding employee abuse, but reports have alleged that ACtivisiO

er the acquisition

CEO Bobby Kotick, a major target of the controversy, will leave the company aft

finalized. The deal was closed on October 13, 2023.
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1.8.4 Brief describe some examples of Microsoft Office Tools
Microsoft Office tools include the following:

¢ Microsoft Outlook

Microsoft Mail Merge
e Microsoft Word

e Microsoft Excel

»  Microsoft PowerPoint
* Microsoft Access

e Microsoft OneNote

e Microsoft Lync

e Microsoft SharePoint

e  Microsoft Publisher

e  Microsoft InfoPath.

1.8.5 Importance of using Microsoft Office-Based Communication Tools
Key reasons why Microsoft tools are important:

e Productivity Enhancement:

9|Page




Qmp ¢ j
[} I;shrv:,xut VILE i

tools for .

NE presentat ¢
1 l}yull , dind I!v,gu,”:au‘iz &erm xl’l' “ ¢ {
S € v, AT

wide € ompatibility:

husinNesses and organizations use Microsoft tools, ensuring
J

¢ e
edamless documents «

,oration across different platforms

user-Friendly Interface:

Microsoft tools are designed with intuitive interfaces, making them accessible to
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. Collaboration Features:

microsoft tools like Teams and SharePoint facilitate real-time collaboration on documents, 31|
’ OW»V.E:'
multiple users to work simultaneously and track changes effectively.

. Data Analysis Capabilities:

excel, with its powerful spreadsheet functions, enables complex data analysis, charting, and

reporting.
e Cloud Integration (Microsoft 365):

Accessing documents and applications from anywhere with cloud storage and online access
through Microsoft 365 enhances flexibility and remote work capabilities.
o Security Features:

Microsoft offers robust security measures to protect sensitive data within its applications.

The Facilitators took participants through Microsoft Word and Microsoft PowerPoint as follows:

1.8.6 Application of Microsoft Office Tools that are regularly use in public and
private offices.
» Microsoft Word

Used to make professional-quality documents, letters, reports, etc., MS Word is a word processo!
developed by Microsoft. It has advanced features which allow you to format and edit your files and

documents in the best possible way.
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submitting them online ‘

. InWorkplace: Submitting letters, bills, creating reports letterheads
£ . S, Sempile docisrme

all easily be done using MS Word Cume

de

. Creating & Updating Resume: One of the best tools to create your resumes and
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and make changes in it as per your experience

« For Authors: Since separate options are available for bibliography, table of contents o

the best tool which can be used by authors for writing books and adjusting it a5 per the

syYJu

and alignment of your choice

« Homes: Most people use Microsoft Tools in their homes for their personal assignments zna

problems. They use the tools to draft reports, write letters and so forth.

1.8.7 Steps in Using Microsoft Word

Follow these simple steps to open MS Word on your personal computer:

Go to Start - All Programs - MS Office -> MS Word.

To create an MS Word doc, follow the steps mentioned above to open Microsoft Word. Then once
the program is open, click on “File” followed by “New”. This opens a new doc where sometning new

can be created.

Since it is used by people of all age groups, in schools, in colleges and for official purposes, having

proper knowledge of Microsoft Word is a must. The preview of the MS Doc file once it is opened

given below:
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, o Features of MS Word
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(lipboard i Font N Paragraph ;

¢ Home

This has options like font colour, font size, font style, alignment, bullets, line spacing, etc. All the basic

elements which one may need to edit their document is available under the Home option.

o Insert
Tables, shapes, images, charts, graphs, header, footer, page number, etc. can all be entered in the

document. They are included in the “Insert” category.

» Design

The template or the design in which you want your document to be created can be selected under

the Design tab. Choosing an appropriate tab will enhance the appearance of your document.
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Page Layout

e Page Layout tab comes options like m g
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references
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like citation, footnote, table of content i ibli
ootions S, caption, bibliography, etc canb
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Review

spell check, grammar, Thesaurus, word count, language, translation, comments etc
’ - Can al| be

racked under the review tab. This acts as an advantage for those who get their document
S reviewed

on MS word.

Apart from all the above-mentioned features, the Page can be set in different views and layout
outs,

which can be added and optimised using the View tab on the Word document Margins and scale
* S

are also available for the benefit of the users.

Wwhen compared with MS PowerPoint, MS Word is more of reading while PPT is more of visual and

graphical representation of data.
» Microsoft PowerPoint

MS PowerPoint is a program that is included in the Microsoft Office suite. It is used to make

presentations for personal and professional purposes.

10.0 How to make a presentation in PowerPoint
,1 Open a blank presentation.
2. Add slides to the presentation.

- Add content to your slides.

4 Include animations or transitions between slides.
+ Consider adding presenter's notes.

©. Save your presentation.
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13.0 Save your presentation

On the File tab, choose Save.

pick or browse to a folder,

3. Inthe File name box, type a name for your presentation, and then choose Save

Save
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15.0 Add pictures
an the Insert tab, select Pictures, then do one of the following:
To insert a picture that is saveq on your local drive Or an interna| Server, cha
browse for the picture, and then choose Insert,

. (For Microsoft 365 subscribers)

Toinsert a picture from our librar
for a picture, select it and choose Insert.

To insert a picture from the web, choose Online Pictures, ang

use the search box t
picture. Choose a picture, and then click Insert.
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Add shapes

You can add shapes to illustrate your slide.

1. Onthe Insert tab, select Shapes, and then select a shape from the menu that appears.
2. Inthe slide area, click and drag to draw the shape.
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-VALUATION OF THE TRAINING WORKSHOP
, \L
16.V ‘he achievement of the training output, the f

acilitator 4

1645t

ked the Participang. .
kshop in the following areas:

o ,hlhi wol
rchievement of workshop objectives
rhe extent to which the Workshop Expectations were met
Facilitators Courtesy, Promptness and Delivery.

participation and Involvement of the Participants.

following were the results of the evaluation:
The

Achi evement of Workshop Objectives
¢

13%of the participants rated the achievement of the workshop objectives as excellent: g7

' 7 S3id it
% indicated it was fair. Figure 1 show the perception
panicipants about the achievement of workshop objectives.

a5 very good; 13% said it was good; whilst 7
w

Figure 1: Achievement of Workshop Objectives

Achievement of workshop objectives
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90%
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70%
60%
50%
40%
30%

20%
-
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} Excellent Very Good Good Fair
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Focilitation and Delivery

Figure 3 shows participants’ responses to the performance of the facilitator in +

and delivery, development of practical skills and impartation of knowledge part

the training as practical, interactive, very insightful, and successful.

20% of the participants rated the facilitation and delivery of the workshop as exce
'twas very good; another 33% said it was good; whilst 13% indicated it was fa
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]
P
%

cacilitation and delivery

Very Good Good

nation and Involvement of Participants
ci

parti ¢ the participants rated the level of participation and involvement as excellent: 3
97% 0

 was very good; 33% said it was good; whilst 13% said it was fair. Figure 4 shows a pictor
Sa|d'

of responses
re 4: Participation and involvement of participants
Figure =+

on participation and involvement of participants.

Participation and involvement

20%
2 .
0%

Excellent Very Good Good Fair

1.9 RECOMMENDATIONS AND CONCLUSION

1.9.1 Recommendations
We wish to recommend that:

1. The Heads of Departments and Units should form part of the target group.
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i hould Increase the budgel for capacily bulldis
1 adically
M‘\; p.”n(.p:m\‘- should share the knowledge and the informatior
. colleagues and sub-ordinates who could not participate in the training workshog
l 5 conclusion |
' ”.l:m Was the general impression that the training program was success
‘\p.ussod by the participants, as indicated in the evaluation exercise
‘ ‘[\pPENmCES SRR T -
i T NAME DES\G}\ET\SL SEX
. 51 'f’}(on. Prosper K. Addo 7
& =y "s Alhassan Hamza \ MCD -
. : '3"'TBright Akompim \ HR (Lead Facilitator)
| A \ Deli Morgan \MlS (Supporting Fac.) o Y
. ?"5"'Wonkor \ Stenographer Grade Il 3
. M/Tﬂge_lgaioa \ Client Service Officer P
7 Simal Rita \ Snr. Executive Officer P
. mOdum \ Snr. Executive Officer M
}'9 Prosper Adri \ Executive Officer M
. Francisca Mensah \ Stenographer Grade || F
Nkumene Suzy \ Senior Typist P
. lbrahim Zelia \ Stenographer Grade || P
. 13 | Alexander Lartey \ Messenger Y
| Fll \ Evelyn Badu \ Storekeeper -
| s S
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